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Introduction

The National Competency Standards are written specifications of skill and knowledge competencies required
in a particular trade. The competency standards are developed in collaboration with United Nations Industrial
Development Organization (UNIDO), GIZ and National Vocational & Technical Training Commission (NAVTTC).

Industry experts from the relevant industries from different geographical locations across Pakistan were
consulted during the development process of these competency standards to ensure input and ownership of
all the stakeholders. NAVTTC approves these competency standards on the recommendation of Industry
Advisory Group (IAG) for the Information Technology Sector.

The National Competency Standards could be used as a referral document for the development of curricula to
be used by training institutions.
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STRUCTURE OF COMPETENCY STANDARDS
Competency Standards are performance specifications that identify the knowledge and competencies an individual needs to
succeed in the workplace. A competency standard has the following elements:

Competency Unit
A competency unit is a statement which points to an outcome that employers will value and is observable and assessable. The
competency unit is derived during the process of Occupational Analysis and is called ‘Task Statement’ in a DACUM Chart.

Overview
An overview is a description of the competency standard. It briefly describes the purpose and linkage of the competency unit with a
job role.

Performance Criteria
Performance criteria statements set the standard of performance of a task in a job role. It describes ‘how well’ a task or competency
unit is to be performed. It should be observable and written in a measurable term. It is one of the basic criterions for conducting
assessment of the performance of a tradesman.

Knowledge and Understanding
Supporting knowledge and understanding statements include the essential knowledge and understanding, covering facts, principles,
procedures, processes and methods. These statements cover the basic knowledge and understanding that is required to master a
competency unit in an occupation.
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Tools & Equipment
All the related tools, equipment and machinery that are required to perform a particular competency unit or task are listed under
this heading.
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COMPETENCY MAP
A. Collect Related Media Content
A1 Collect
Script/Storyboard

A2 Grab Video

A3 Grab Audio

A4
Collect
Stock Footage

A5 Collect
Stock Art

Digital

C4 Handle multiple
sequences

C5 Perform Rough
Cut

C6 Provide
Revisions

C10 Convert to
external mediums

D5 Cut using Blade
tool

D6 Perform Pen
Tool

B. Transcode Footage
B1 Mark Basic File
Formats

B2 Convert File
Formats

C. Perform Non-Linear Editing
C1 Import Footage

C2 Preview Footage

C3 Perform
Labeling &
Organizing of
Footage

C7 Perform Color
Grading

C8 Perform Render in
required file format

C9 Export Project

D. Perform editing in Adobe Premiere
D1 Perform Mark in
& Out tool
D7 Operate
Timeline Zoom
Option

D2 Scrub though
Video

D3 Trim Footage

D4 Transform
Footage

D8 Apply Effects

D9 Apply
Transitions

D10 Modify
playback speed

D11 Synchronize
Audio

D12 Adjust Audio
Levels & Channels

D13 Add Basic
Titles & Credits

D14 Operate
Export tool

D15 . Perform
Printing to external
medium

E. Perform editing in Final Cut Pro
E1 Perform Mark in
& Out tool

E2 Scrub though
Video

E3 Trim Footage

E4 Transform
Footage

E5 Cut using Blade

E7 Operate
Timeline Zoom
Option

E8 Apply Effects

E9 Apply
Transitions

E10 Modify
playback speed

E11 Synchronize
Audio

E6 Perform Pen
Tool
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E12 Adjust Audio
Levels & Channels

E13 Add Basic Titles
& Credits

E14 Operate
Export tool

E15 Perform
Printing to external
medium

E16 Create sub clips

E17 Working with
Freeze Frame and
Still images

1. Unit Title: Collect Related Media Content
Competency

Overview

Performance Criteria

Unit
A1.Collect

Knowledge &

Tools & Equipment

Understanding
To obtain the

Script/Storyboard roadmap and

You must be able to:
P1.Read script and compare with

understand the

storyboard to understand the scope of

basic theme. Form

the project

relevancy between

P2. Perform Visualizing / Perceiving

the said script and

P3. Make notes

You must know and
understand:
K1. Competency to read
and comprehend the



Computer /
Editing suite



Stationary



Computer /

script
K2. Knowledge of the
key terminologies

storyboard
A2.Grab Video

Grabbing / capture

You must be able to:

You must know and

footage from the

P1. Check equipment availability and

understand:

recording medium

performance

K1. Should know how to

into the editing

P2. Verify patching / connectivity

operate the software and

suite

P3. Create project with relevant

hardware

settings in sync with recorded

K2. Should know how to

capturing

medium and project workflow

patch /connect

medium

Editing suite


Playback
medium



Recording /
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requirement.

K3. Should know video

P4. Log and Capture

types, playback, video

P5. Preview after capture

standards, medium to
medium conversion and
formats

A3.Grab Audio



Grabbing audio

You must be able to:

You must know and

from different

P1. Check equipment availability and

understand:

medium into the

performance

K1. Should know how to

editing suite to

P2. Verify patching / connectivity

operate software for

(for conversion

fulfill requirement

P3. Log and capture (audio only)

audio editing and

and recording)

and verify audio

P4. Preview after capture

necessary hardware

needs i.e. Natural

P5. Import into project If audio is in

K2. Should know to

sound, Music,

digital format,

patch / connect

Narration/voiceover

K3. Should know audio

and/or audio sound

types, playback, audio

effects.

standards, project

Computer /
Editing suite





Audio software

Recording /
capturing
medium

requirements, conversion
and formats
A4.Collect Stock

To gather footage

You must be able to:

You must know and

Footage

other than the clips

P1. Note keywords for searching

understand:

shot by the camera

relevant stock footage

K1. Knowledge about



Computer /
Editing suite



Required
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software

for the specific

P2. Ensure desired quality and

archival data

project

resolution of the footage (internet,

K2. Knowledge about

SD/HD)

formats and conversion

external HDD or

P3. Utilize appropriate archival

K3. Access to various

internet and

software

sources



Connection to

archival system

P4. Organize footage in respective
folders
P5. Preview stock footage in realtime


A5.Collect

Collect

P1. Note keywords from the script to

You must know and

Digital Stock Art

photographs,

collect artwork where required.

understand:

backgrounds,

P2. Look out for the digital stock art

K1. Knowledge about

E.g. Adobe

layouts, templates,

P3. Ensure the resolution of the

software for digital

Photoshop, Adobe

CG (computer

digital stock art to match with the

artwork

graphics), animated

video specifications of the project

K2. Resource and access

objects, cutouts etc.

P4. Organize the data

to digital archive and

via internet,

P5. Preview on timeline to check

sources

archives or

issues such as alpha etc.

K3. Understand formats

scanning

Required
software

Illustrator, Adobe
Bridge etc


Connection to
external HDD
and archival
system

K4. Understand color
systems and their
differences.
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2. Unit Title: Transcode Footage
Competency

Overview

Performance Criteria

Unit

Knowledge &

Tools & Equipment

Understanding

B1.MarkBasic

This competency is

You must be able to:

You must know and

File Formats

about different file

P1.Note and assess project

understand:

formats for initial

specification correctly

K1. Understand basic file

assembly, which

P2. Select material to match work

formats

may be required for

specification.

K2. Knowledge of

matching as per

P3. Review files in terms of types,

conversion

project requirement

playback, speed, quantity and quality.

K3. Problem solving and



Computer /
Editing suite



Video editing
Software



Conversion
software

techniques to achieve
project specification.
B2.Convert File

This competency is

You must be able to:

You must know and

Formats

about converting

P1. Note and asses project

understand:

desired footage to

specification correctly

K1. Understand basic file

other file formats

P2. Select footage to be converted.

formats

using conversion

P3. Review files in terms of types,

K2. Knowledge of

software

playback, speed, quantity and quality.

conversion software

P4. Convert material with appropriate



Computer /
Editing suite



Video editing
Software



Conversion
software

settings of the software
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P5. Preview conversion real-time

3. Unit Title: Perform Non-Linear Editing
Competency

Overview

Performance Criteria

Unit

Knowledge &

Tools & Equipment

Understanding

C1.Import

To import / gather

You must be able to:

You must know and

Footage

footage to prepare

P1. Collect files from relative path

understand:

for editing

P2. Create bin/ folder

K1. Knowledge about

P2. Import and organize accordingly

Video editing system.

P3. Adjust pre-render folder

K2. Video and Audio file

P4. Save the project

management



Computer /
Editing suite



Video editing
Software

P5. Adjust auto save file path
P6. Using appropriate naming
conventions for quicker access
during editing
Page 11



C2.Preview

To review and

You must be able to:

You must know and

Footage

relate footage with

P1. Double click the footage and

understand:

the script / story

preview in previewing window

K1. Understanding the

board.

P2. Check for glitches in footage

equipment and software

P3. Checkout for audio / video sync

K2. Knowledge about

P4. Relate video with the script /

software elements

previewing

storyboard

relevant with previewing

monitor

P5. To ensure audio / video quality
C3.Perform

To organize

You must be able to:

You must know and

Labeling&

footage according

P1. Perform naming the chunks of

understand:

Organizing of

to the script

footage with respect to the

K1. Knowledge about

Footage

respectively

storyboard

managing bulk

P2. Give unique names to the footage information in a
in a systematic manner for smoother

systematic way

workflow

K2. Know about all

P3. Mark different tapes for multiple

labeling tools and

camera shots.

labeling features of that

P4. Counter check the footage to

specific software.

Computer /
Editing suite



Video editing
Software



External



Scopes



Headphone



Computer /
Editing suite



Video editing
Software



Storyboard

ensure all data is complete
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C4.Work with

Synthesizing

You must be able to:

You must know and

multiple

different sequences

P1. Create required amount of

understand:

sequences

to assign every

sequences according to the footage

K1. Knowledge about

scene with their

P2. Perform naming of different

handling sequences on

individual

sequences

the related software

sequence.

P3. Drag and Drop the clips to the

K2. Understanding that

respective sequence

sequences contain

P4. Pre-render / Buffer the sequences

timeline and CTI



Computer /
Editing suite



Video editing
Software

(Current Time Indicator)
C5.PerformRough The process of

You must be able to:

You must know and

Cut

editing the footage

P1. Cut footage on timeline

understand:

to get rid of

P2. Synchronizing Audio / Video

K1. Knowledge of short

unwanted footage

P3. Edit Raw footage

keys and editing tools

P4. Create footage using relevant

K2. Knowledge of

editing technique i.e. butcher cut,

editing techniques



Computer /
Editing suite



Video editing
Software



Editing tools

sifting, assembly, multiple task etc.
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C6. Provide
Revisions

To assemble the

You must be able to:

You must know and

project in its final

P1. Trim the video according to the

understand:

shape

script

K1. Knowledge about

P2. Balance audio levels

technical terminologies

P3. Balance music levels if required

K2. Usage of relevant

P4. Avoid ripples between two clips

tools

P5. Choose audio/ video transitions

K3. Editing grammar

if required

K4. Knowledge about

P6. Adjust insertions on different

editing techniques



Computer /
Editing suite



Video editing
Software

layers
P7. Embed graphic layouts on actual
video
P8. Select Third Party color
correcting software
C7.Color Grading

Process of altering

You must be able to:

You must know and

and enhancing the

P1. Using the task bar to correct the

understand:

color of the motion

colors

K1. Basic knowledge of

picture

P2. Using the color tools from the

color balancing and

electronically or

bin as required.

mixing

digitally. To ensure

P3. Pick and drop the related color

K2. Knowledge about

the over exposed or

correction filter

color tools



Computer /
Editing suite



Video editing
Software
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under exposed

P4. Using color correction bar in the

details of the shots

3 way color corrector

and correct them,

P5. Balancing the colors using 3 way

in order to enhance

color corrector.

the expression of
the footage in terms
of color.
C8.Render in

A process of

You must be able to:

You must know and

required file

creating a video file P1. Ensure that no clip is offline

understand:

format

that contains entire

P2. Select the points of that sequence

K1. Knowledge about

sequential time line

on the timeline as mark-in and mark-

editing tools, rendering

in a desired output

out

options

format using

P3. Select short keys to set mark-in

K2. Knowledge about

certain codecs

and mark-out

broadcasting mediums



Computer /
Editing suite



Rendering cards



Video editing
Software

P4. Select the desired format per
project specification
P5. Select the appropriate field i.e.
lower filed, upper filed or
progressive
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4. Unit Title: Perform editing in Adobe Premiere
Competency

Overview

Performance Criteria

Unit

Knowledge &

Tools & Equipment

Understanding

D1.Mark in &

Mark in and out are

You must be able to:

You must know and

Out

used for defining

P1. Create bin and import visuals

understand:

the clip on

P2. Select the desired clip

K1. Knowledge about

previewing window

P3. Pre-render visuals

specific keys / menus

which has to be

P4. Copy/cut the selected clip

relevant to this feature

treated or edited

P5. Acquire the length of the clips

D2.Scrub though

It provides audio

You must be able to:

You must know and

Video

and video output

P1. Create a sequence and name it to

understand:

simultaneously

drag the clips onto the timeline

K1. Knowledge about the

while moving CTI

P2. Drag CTI (Current Time

tools used to scrub

(Current Time

Indicator) over the clip on the

through video

Indicator) over the

timeline using the mouse or select

clips on the

left/ right arrow keys to scrub through

timeline

the clip



Computer /
Editing suite



Adobe Premiere



Computer /
Editing suite



Adobe Premiere

P3. Ensure the quality of the
footage/clip on the previewing
medium.

Page 16

P4. Play the footage manually in the
desired playback speed
D3.Trim Footage To select the

You must be able to:

You must know and

required video on

P1. Double click and select raw

understand:

your timeline to

footage from project files to preview

K1. Knowledge of short

fine-tune the cut

P2. Select keyboard short keys or

keys and tools

point and adjust the

mouse to select required clip and drag K2. Knowledge of

clip duration

to timeline



Computer /
Editing suite



Adobe Premiere



Computer /

editing grammar

P3. Drag to timeline then use cut or
trim tool to remove unwanted
portions of the raw footage
P4. Fine-tune the time durations and
audio / video cut points of the footage
on the timeline.
D4.Transform

This involves

You must be able to:

You must know and

Footage

changing or

P1. Scale / resize frame size of video

understand:

modifying the

clip by changing the values of scale

K1. Knowledge of video

properties of the

P2. Rotate clip by modifying the

distortion and pixilated

clip as per project

value of degrees of the clip as per

video

specification like

your requirement

K2. Understanding of

scaling, rotating,

P3. Change anchor point by

anchor points

Editing suite


Adobe Premiere
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changing anchor

modifying the values of x and/ or y

K3. Knowledge of short

point, cropping or

axis. this enables the center/anchor

keys and cropping

adjusting opacity

point to change hence modifying the
point which the clip could use as
reference to rotate or scale
P4. Modify the opacity of the clip if
required

D5.Cut using

This task involves

You must be able to:

You must know and

blade tool

knowing how to cut

P1. Put the desired footage on the

understand:

desired footage in a

timeline

K1. Understanding of

clip. The most basic P2. Select blade tool

short keys and cutting

edit is straight cut,

P3. Perform cut from mouse click

tool

just like using razor

P4. Perform cut via short key without

blade on a piece of

use of selection tool

film.

P5. Select the cut points by the



Computer /
Editing suite



Adobe Premiere

current position of CTI (Current Time
Indicator)
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D6.Perform Pen
Tool

This tool is used

You must be able to:

You must know and

basically for

P1. Select pen tool

understand:

varying the

P2. Mark the first point from where

K1. Basic knowledge of

instantaneous levels the level have to be varied

using pen tool

of video opacity

P3. Mark the end point on the yellow

K2. Knowledge about

and audio gain of

ribbon

video opacity

the clip on to the

P4. Move the yellow ribbon between

K3. Knowledge of audio

timeline.

the two yellow marks up and down

gain / level parameters

for adjusting the value.

K4. A yellow ribbon on



Computer /
Editing suite



Adobe Premiere



Computer /

the both A/V gain layers
of the timeline represent
the continuous level of
video opacity and Audio
Gain. Pen Tool provides
yellow dot to select the
range in between two
dots, the level can be
varied by moving the
dots up and down.
D7.Operate

Timeline zoom

You must be able to:

K1. Basic use of

Timeline Zoom

provides an option

P1. Press “+” key for zoom in

keyboard keys
Page 19

Option

for the editor to

P2. Press “-“ key for zoom out

K.2 Basic knowledge of

preview the work

P3. Press “\” back slash for the entire

timeline tools

done on the

timeline preview.

Editing suite


Adobe Premiere



Computer /

timeline by
expanding (zoom
in) or squeezing
(zoom out). This
option is to
facilitate the edit or
to check and apply
cut to cut editing
D8.Apply

Effects are used to

You must be able to:

You must know and

Effects

transform the

P1. Locate the desired effect in

understand:

Audio and Video

effects folder

K1. Knowledge about the

by varying through

P2. Search the desired effect by

parameters of X and Y

different attributes

typing the keywords into the search

axis or coordinates of the

and elements of the

bar of the effects allocated bin.

video effect parameters.

composite Video or

P3. Drag and drop the desired effect

K2. Knowledge about

audio.

onto the clip to be enhanced

video projection and

P4. Select the clip and the properties

audio fidelity

Editing suite


Adobe Premiere

of the acquired effect open into the
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effect tab of the preview monitor.
P5. Enhance the clip by applying
changes into the clip in the effect
label of the preview monitor.
P6. Render the applied effect and
preview

D9.Apply

Transitions are the

You must be able to:

You must know and

Transitions

effects in Adobe

P1. Select the edit point of the two

understand:

Premiere used for

clips on the timeline of the sequence

K1. Knowledge of

gradual mix of two

P2. Drag the desired transition from

transition

clips at the cut

the effects folder, and drop it over the

K2. Adding transition to

point with some

cut mark in between two adjusting

the cut mark

creative pattern.

clips

K3. Modifying the

P3. Trim frame wise , the transition

properties of the

as per requirement

transition

P4. Adjust the direction of the

K4. Knowledge of

transition from A -> B to B-> A as

default and favorite

per desire

transitions



Computer /
Editing suite



Adobe Premiere

P5. Modify the properties of the
Page 21

transition provision is provided by
default.
D10.Modify

This tool helps to

You must be able to:

You must know and

playback speed

modify the

P1. Select the clip, the speed of which understand:

playback in terms

is to be modified.

K1. Knowledge of speed

of frame rate, either

P2. Open modify playback speed

and direction

fast or slow or even

option

K2. Constant and

reversed.

P3. Type in the change in percentage

variable speed

of the clip speed, which is 100% by

parameters.

default.

K3. Knowledge about

P4. Click / check box of the reverse

time lapse.



Computer /
Editing suite



Adobe Premiere



Computer /

option if the change in direction is
required.
P5. Close the option window
P5. Render the enhanced clip
D11.Synchronize Once the clip is in

You must be able to:

K1. Art of identifying the

Audio

your project, it

P1. Listen thoroughly and calculate

out of sync audio.

contains video and

the video frames, lagged or advanced

K2. Have an idea to find

audio to form

according to the speed of audio. If the

the number of frames to

footage. The audio

correction error is +4 frames, drag

be corrected.

is always

right the audio layer under the video

Editing suite


Adobe Premiere
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synchronized

layer. If the error is -4 frames, drag

according to the

left the audio layer for the correction.

video. In an

P2. Move the video and audio layer to

interview, the lip-

and fro after correction.

synchronization is
most important, as
the speed of audio
is synchronized
with the movement
of lips of the
spokesperson. If the
audio
synchronization
syncs out with the
video, the link is
broken between
these two, to
correct such error
Sync audio
technique is used.
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D12.Adjust

Audio is specified

You must be able to:

You must know and

Audio Levels &

in terms of

P1. Highlight the audio layer of the

understand:

Channels

channels i.e. left or

clip, whom to be adjusted the audio

K1. Know how about

right. Some times

levels.

measuring the audio

more than two

P2. Pick the audio level through

levels

channels are also

mouse pointer or by using the short

K2. Knowledge of audio

used according to

key in order to level up or down

matching on the same

the project scope.

through keyboard.

audio layer

P3. Monitor the change in level

K3. Procedures of audio

attribute in terms of +- db to follow

fade in and fade out



Computer /
Editing suite



Adobe Premiere



Computer /

the uniformity in the levels of
calibration.
P4. Match the audio level of all the
audio clips on the audio layers of the
timeline in terms of values, to avoid
audio jumps.
P5. Measure the level of audio on
meter
D13.Add Basic

Once the editing is

You must be able to:

You must know and

Titles & Credits

completed the titles

P1. Open title box

understand:

and credentials are

P2. Create the desired titles or credits

K1. Skills of making or

Editing suite
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to be added on to

P3. Name and save the titles

creating title

the whole project.

P4. Close the window

K2. Understanding

These titles may be

P5. Drag the saved title from the main pictures and stock art etc.

superimposed or

bin, and drop it over the video layer.

placed on screen as

P6. Adjust the title layer as per desire

per creative needs

P7. Render the title layer.



Adobe Premiere



Computer /

using animated
titles, 3D, graphics,
lower third graphics
and ending
credentials with
applied adjustable
parameters such as
speed, opacity etc.
D.14. Operating

Once the project is

You must be able to:

You must know and

Export Tool

completed after

P1. Apply mark in and out with area

understand:

rendering it needs

selection overhead bar.

K1. Knowledge about the

to export in some

P2. Open export settings

file formats

desired format.

P3. Select the required format

K2. Knowledge about

The conversion

P4. Apply the file output name

compression.

may be in some

P5. Check export audio option

K3. To measure disk

Editing suite


Adobe Premiere
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formats other than

P6. Click export

formats and file system.

the native format,

K4. Know how about

like mp4, mpg,

video formats

mov etc.
D15 Perform

If the project needs to

You must be able to:

You must know and

printing to

be exported onto an

P1. Apply Mark in and out with area

understand:

external medium

external media like

section overhead bar

K1. Inters tape

digital magnetic tapes

P2. Check output deck (VTR)

or through real-time

availability and patching

DVD writers, it needs

P3. Check project integrity for no clip

‘export tape’ tool.

offline or un-rendered errors.



Computer /
Editing suite



Adobe Premiere

P4. Check export
P5. Insert tape in VTR tape intake
P6. Rewind the tape (cassette)
P7 Apply CTL and blue background
through interval color generator
P8. Adjust audio levels of the project on
VTR by going 1 Kc as a reference 0db
P9. Start recording by pressing record
and play button at a time
P10. Preview / monitor the project during
tape recording
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5. Unit Title: Perform editing in Final Cut Pro
Competency

Overview

Performance Criteria

Unit

Knowledge &

Tools & Equipment

Understanding

E1. Mark in and

In and out points

You must be able to:

You must know and

out.

allow you to define a

P1. Double check in the sequence in the

understand:

specific portion of a

browser to open it on the timeline.

Specify where a clip should

clip or sequence for

P2. Choose mark and (or press I) to set an

be placed in your sequence

editing, deletion,

In point in the sequence.

and to select a section of a

copying, and paste

P3. Move the play head several seconds

clip for editing, copying,

and so on a mark in

later in the time line.

pasting or any other

the first frame of the

P4. Choose mark out (or press O) to set

operations.

clip to be edited in

and out point in the sequence.
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the sequence. A mark
out specifies the last
frame of the clip to
be used.
E2. Scrubbing

The purpose is to

You must be able to:

You must know and

through video

preview audio and

P1. Scrubbing of audio layer reveals the

understand:

video in

levels of audio and to analyze it.

Frame editing knowledge is

instantaneous

P2. Rechecking the initial and final

must.

manner. Either is

frames of the audio.

used for the purpose

P3. Analyze the playback speed.

of previewing audio

P4. Preview Quality of through

levels or previewing

scrubbing.

video quality or

P5. Preview Quality of video.

rechecking the

P6. Observe ripples which can also be

sequence of clips

done by scrubbing
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P7. Recheck Initial and final frames.

E3. Trim footage

Precision adjustment

You must be able to:

You must know and

(anywhere from one

P1. Choose sequence using command 7

understand:

frame to several

P2. Double click an edit point in the line

K1. Linked selection –

seconds). Adjusting

with the selection, Ripple or Roll tool.

make sure that clip items

clip duration by much

P3. Click an edit point or drag around one

that refer to same media

Editing suite
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larger amount, you

or more edit points using the editing

files are linked together

are still trimming.

selection tool.

when editing is being done
on the timeline.
K2.lining up the edits with
other items in the sequence
by turning on the snap tool.
K3. Lock tracks – to prevent
unwanted changes in the
sequence of finalize clips or
those clips which would be
edited later.
K4. Press command key to
make small changes to edit
points or cliffs.

E4. Transform

This enables the

You must be able to:

You must know and

footage

modification of

P1. Double click on the clip which is

understand:

attributes/properties

placed on the timeline to activate fax

K1. Understanding the basic

of a clip’s digital art

control table.

attributes of the clip as

as per project

P2. Select Effects control tab.

provided by the editing

specification. Such as

P3. Change the designed values of scale

software.

position, scaling,

as required.

K2. Understanding the

rotation, anchor

P4. Change the desired values of position

effects resulting from
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point/center point and

as required to position the clip on the

changing the values of the

opacity.

frame with respect to another point.

attributes of the clip.

P5. Change the desired value of quotation
as required to rotate the clip on the frame
with respect to another point.
P6. Change the desired value of opacity
as required modifying the transparency of
the clip.
E5. Use blade

Basic editing tool to

You must be able to:

You must know and

cut/ razor

start the editing, it is

P1. Put sequence or footage on the time

understand:

used to have a

line.

Understanding of start key

straight cut on the

P2. Make cut with the razor blade tool

training tools of FCP.

video to help you in

P3. Make cut pressing Control-V
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the editing process.
E6.Pen tool

The pen tool is used

You must be able to:

You must know and

to refine the attributes

P1. Change the opacity of videos on the

understand:

of video and audio

key frame level for either creating

Information of key frame

layers, on a detail

purpose or editing purpose

level editing

frame level

P2. Change the level of audio to a certain

Editing suite


Final Cut Pro



Computer /

extent either of fade in or fade out
proposes
E7.Zoom tools

Changing the size of

You must be able to:

You must know and
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time line is necessary

P1. Choose zoom-in or relevant shortcut

understand:

to either have over

keys to such extent where editing can be

Working with multiple

view of the whole

done even at frame-to-frame level.

layers.

project at large or the

P2. Choose zoom-out or relevant shortcut

Frame level editing

editing of the clips at

keys to such extent where the whole

Basic editing technique

frame level

project can be viewed, also for the
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positioning of layers can be done at this
level.
E8. Applying

Applying effect

You must be able to:

You must know and

Effect

provide to process

P1. Select one or more clips in the

understand:

and modify the visual

timeline, drag a filter from the Effects tab

Using video filter in

content to your clips

of the browser to one of the selected

different ways. Installing

or footage. Modify

chips in the timeline.

and managing video effect.

and enhance clips in

P2. Choose Effect from the sub menu

Applying a filter to a clip.

various ways.

P3. Open a sequence clip in the viewer.

Copying and pasting a clip



Choose Effects > Video Filters
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effects or filter.

then choose a filter from sub
menu


Drag a filter from the Effect tab
of the browser directly into
viewer.

P4. Select the range Selection tool in the
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tool plotter.
P5. Drag across the part of the clip to
which you want to apply the filter
P6.Apply filter to one at the time
E9.Applying

A transition is a

You must be able to:

You must know and

transition

visual effect to

P1.Start on the cut: Chose this alignment

understand:

change video from

if you want the last frame of the outgoing

Adding transition, moving

one clip to another in

clip to be fully visible before the

copying and deleting

a specific manner

transition beings

transition, modifying

P2.Chose this alignment if you want the

transition in the timeline,

cut point between the two clips to be mid-

working with default
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point in the transition
P3. Use this alignment if you want the
first frame on the incoming clip to be
fully visible
P4.Select an edit point between two
video clips position on time line plan
head of the designed edit point then
previous
P5.Control_click and edit point between
two clip in the time line then choose add
transition from the short cut menu
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E10.Modifying

Default speed of all

You must be able to:

You must know and

play back speed

clips is 100%

P1.Perform fit to fill edit in the time line

understand:

Slow motion : Speed

set sequence in and out to the part of your

Knowledge about speed

index 100%

sequence you want to fill

basic constant and visible

Fast motion :speed

P2.Make sure that the correct destination

speed setting

over 100%

track are set in the time line

modifier for

Variable speed:

P3.Open the clip in the viewer

variable speed

Speed changes over

P4.Drag the clip from the viewer to refit

adjustment fit to

time using shaping

to fill

fill edit shot key

feature

P5. Modify Constant speed
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Keyboard

I. Select on clip in the time line or move
the play head over the clip in the time line
II.Chose modify speed or press cancel
III.Control click the clip, then choose
speed from shortcut menu
IV.Select speed option from the effect
you want to the click ok
E11.Sync audio

Working on varying

You must be able to:

You must know and

the audio according

P1.Drag this line up or down to change

understand:

to the video

the sound levels

K1. Knowledge about using

P2.Select Level slider to adjust volume of

waveform display

the currently selected audio clip

K2. Knowledge about
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P3. Adjust the level of the key frame at

editing audio in the timeline

the current position of the play head

K3. Knowledge about audio

P4. Add a new key frame to the level

control in the viewer

overlay and adjust it to the new level
P5. Hold down the command key while
dragging the level slider to adjust the
audio level with more precision.
E12. Adjust

Control audio levels

You must be able to:

You must know and

Audio Levels and

on the line using

P1. Open sequence on the timeline then

understand:

Channels

audio mixer. You can

chose sequence

K1. Knowledge about

make adjustments to

P2. Click timeline options tab, then select

Adjusting audio levels on

multiple clips at once, the show key frames over lays check box

the timeline

as well as add key

you can also select the audio overlays

K2. Knowledge about

frames to automate

control over the timeline.

Pairing audio on the

mixing levels over

P3. Select the clip overlays control at the

timeline

time.

bottom of the timeline to display

K3. Knowledge about

overlays.

Adjust clip audio level

P4. Drag the audio level overlay up or

using key frames.
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down to adjust the audio level.
P5. Use pen tool platter for the
adjustment of audio levels.
E13. Add Basic

Titles including

You must be able to:

You must know and
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titles and credits

opening and closing

P1. Click the video or audio tab in the

understand:

credits and titles used

viewer, then choose a text generator pop-

K1. Installing required

in the lower part of

up menu. Alternatively you can also

software.

the screen. You can

double click text generator in the effects

K2. Knowing how to make

create titles and

tab.

sure titles fit on screen

credits with in final

P2. Click the contact tab In the viewer.

K3. Knowledge of using

cut pro with text

P3. Type the text that will appear in your

text generator on FCP

generators

movie.

(Final Cut Pro)
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P4. Set your destination track In your
sequence in the timeline
P5. Set the sequence or clip in and out
points.
P6. Click a video tab in the viewer then
drag the clip from the viewer to the
timeline

E14. Operate

After editing is done,

You must be able to:

You must know and

Export Tool

the desired format for

P1. Specify the initial editing points of

understand:

the purpose of

the sequence.

K1. Knowledge about the

broadcasting is

P2. Observe for any ripples.

video formats

achieved by export

P3. Specify the desired format, frame

K2. Knowledge about the

tool

rate, codecs and the quality of the project.

transition requirements
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P4. Specify the path to export.

regarding fields.

P5. Review the exported project

K3. Know how about frame
size, frame rate and codec
software

E15: Print to

This task enables the

You must be able to:

You must know and

tape

user to save the final

P1. Select ‘Print to tape’ to enable

understand:

work on tape or DVD

options to initialize printing final edited

K1. Know how to connect

or any external

content top tap

VTR and equipment

medium

P2. Change, appeared options such as

K2. Knowledge of

color bar, blank and values for duration to

specification of project and

precede the final content and be used in

delivery medium and

the end

requirements.
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VTR / Recording
Medium

P3. Check if VTR is connected and
connections are established.
P4. Queue tape manually to selected time
code or allow FCP to queue to selected
time automatically.
P5. Allow software to print the content to
tape
E16: Create sub

Sub clips allow you

You must be able to:

You must know and

clips

to work more easily

P1. Open a clip in the viewer

understand:

with lengthy media

P2. Set in and out points

K1. Know how to use short
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by breaking up a

P3. Choose Modify > Make sub clip.

keys i.e. Command – U,

single clip into many

Press command + U

Command + F etc.

smaller pieces.

P4. Find the frame you want to match

K2. Possess techniques for

P5. Chose view match frame and press

breaking larger clips into

option Command + F

sub clips

P6. Create marker in a clip and then turn
into sub clips
E17: Working

Still images and

You must be able to:

You must know and

with Freeze

freeze Frame are used

P1. Make sure the frame you want for a

understand:

Frame and Still

as placeholder

freeze frame is displayed in the viewer.

K1. Knowing how to Create

images

graphics during

P2. Choose modify make freeze frame

freeze frames, using still

editing as background (Shift + N)

images and graphics in your

images for multilayer

P3. Add the freeze frame from the viewer

sequence, exporting still

composition, provide

to the timeline

images

continuity when no

P4. Drag the Freeze Frame from the

video is available

viewer to the timeline.
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P5. Drag the frame to the browser to
create a master clip.
P6. Create graphic with the correct frame
size
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6. Unit Title: Communicate with other
Competency

Overview

Performance Criteria

Unit

Knowledge &

Tools & Equipment

Understanding

F1. Build

This unit of

P1. Offer after sales services.

You must know and

1. Data of customers

relations with

competency is

P2. Update customers with new products.

understand:

2. Mobile

customers

designed to build

P3. Kind and honest with customers.

K1. Maintaining data of

3. Computer

good relationship

P4. Be polite with customers in dealing.

related customers.

4. Reference

with customers.

P5. Keep record of customers.

K3. 4Ps and 4Cs of

5. Chambers

P6. Share details of new products with

customers.

customers.
F2. Supervise

This unit of

P1. Perform the duty with other team

You must know and

1. Notice board

workers

competency is

members.

understand:

2. Schedule

designed to manage

P2. Supervise the work and achieve

K1. Assigned task

3. Web portal

the workers and other

targets in minimum time.

K2. Management skills

personnel that can

P3. Give clear direction to workers.

K3. Leadership qualities

help in improving

P4. Check efficiency of workers/ team

K4. Being team leader

work quality and

members.

quantity.

P5. Motivate the workers in order to
enhance the efficiency of workers.
P6. Make work environment comfortable
for workers.
P7. Evaluate workers on the basis of
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performance.
F3. Follow

This unit of

P1. Seek guidance from seniors.

You must know and

1. Family members

instructions from

competency deals

P2. Follow the instructions from seniors.

understand:

2. Friends of family

seniors

with following

P3. . consult seniors in case of

K1. Knowledge of seniors

instructions of the

emergency.

to enhance the efficiency of

members.
3. Senior

seniors to perform

products.

businessmen

proper job.

K2. Senior suggestions and

from different

instructions.

chambers
4. Senior
government
officials.

F4. Establish

This unit of

P1. Keep good relationships in order to

You must know and

1. Record register

linkage with

competency is to

supply material in time.

understand:

2. pen

suppliers.

develop good

P2. Maintain record of the suppliers.

K1. Supply chain

relationships and

P3. Identify relevant suppliers.

management.

linkage with raw

K2. Maintaining record of

material suppliers.

suppliers.
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